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What you need to Build: 
1. CD Burner and blank CD's 

Almost every system out there has a CD Burner now, most new computers have been shipping 
with DVD Burners for at least the past year.  

 
2. Windows® XP CD, with at least Service Pack 1 (SP2 is highly recommended) 

If your CD does not have SP1 or SP2 included on it you can easily "slipstream" a Service Pack 
using a program called AutoStreamer. Instructions for slipstreaming are on the "slipstreaming" 
page of this site. Do not use a source that was "modified" by programs that claim to stream 
hotfixes or drivers into your XP CD. Only use a true XP CD or one that is slipstreamed properly 
with only an official Service Pack from Microsoft. 
 
TIP- Unsure about what Service Pack your CD has? Look at the root of your XP CD for files 
ending with a .SP1 or .SP2 extention. Whichever extension you find tells you what Service Pack is 
installed on your CD. 

 
3. Download UBCD4Win 

Click the "Downloads" link to the upper left of this page and download the project. The project is 
now only ONE download. Included in the download are our project files, our "drivers" package, 
and our OEM PE Builder. 

 
Extracting, setting up, and building UBCD4Win: 
1. Run the UBCD4Win EXE file. 
 
2. Follow all the instructions/prompts that come up. Do not install to a folder with spaces in its name. 

Our HashCheck tool checks for this and warns users, however people continue to ignore that 
warning and end up with errors when they try to build. Please pay attention to any messages that 
our Installer or HashCheck may produce. Be aware that your antivirus software may report viruses 
or trojans when you extract UBCD4Win, please view the FAQ topic on this for more information 
HERE. PLEASE- make sure you run the EXE, do not use any other extraction tool to extract the 
project files.  

 
3. Insert your XP CD with SP1/SP2 into a CD Rom drive. 

 
It is highly recommended that users copy their XP CD to their hard drive. Simply because it helps 
reduce read errors from your CD drive and it will speed up the build process. If you choose to do 
this: 
        a. Create a "XPCD" folder on one of your internal hard drives. 
        b. In Windows Explorer, select from the menu: Tools > Folder Options > View tab. 
        c. Check that the [show hidden files and folders] radio button is selected and the [hide 
protected operating system files] is unchecked. 
        d. Now copy the folders and files from your CD drive to the "XPCD" folder on your hard drive.  

 
4. Launch UBCD4WinBuilder.exe (located in your C:\ubcd4win folder) 
 
5. If this is the first time you have run UBCD4Win PE Builder you will see this message, please read 

it:  
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6. You will then see this message, select NO. The search can take a long time to find your files. 
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7. This is the main screen. All options are now available from the menus or buttons. On this main 
screen you only need to modify a few items, please refer to the image above. The options that 
really matter to a successful build are in bold below, the others are optional and are designed for 
more experienced users: 

 

 
 "Source" needs to be directed to the folder where you copied your XP CD to or the CD 

drive where your XP CD is located. 
 

 "Custom", NO information is necessary for that option when building UBCD4Win. Please 
do not use this option unless you understand what it does! 
 

 "Output" is where you would like the files that UBCD4Win PE Builder modifies, extracts, 
and creates located. This is basically the folder that the builder uses to do all of its work, 
you can keep it as the default "BartPE." 

 
 Make sure the "Create ISO image" box is checked and a filename is entered, if not 

an ISO file will not be created. The path and file will be created if they do not exist. But 
please remember that the filename must have an "iso" extension or it will not be created. 
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 "Burn to CD", a good option. If you check this option, UBCD4Win Builder burn the ISO 
image to a CD after the ISO file is generated. You must have a blank CD in your burner in 
order for this to complete. You can use this option if you wish, however I personally prefer 
to use Nero, ImgBurn, or another CD burning application to do this. Burning instructions 
are on the "Burn ISO" page of the site. 

7. "Plugins" button. I strongly suggest you click this button to update or customize your build. You 
may also need to disable and/or enable plugins according to the OS you are using to build with. 
Almost all of the plugins included in the project are by default set to be installed. Updating will also 
be necessary so you have the latest AntiVirus and AntiSpyware definitions included on your CD. 

**Version 3.06 driver change. Our "UBCD4Win driver pack" for network devices is still included in 
the latest version, however mass storage drivers have been removed. In their place we now have 
BTS mass storage drivers. The BTS driver pack includes drivers for many devices, so you should 
be able to see any SCSI, SATA, etc., hard drive hooked up to your system. 
 
**You can update many AntiVirus and Malware tools before building the project. You will see a 
<CONFIG- to update> at the end of the program's name on the "plugin" screen. So, simply click 
on the plugin to highlight it and then click the "config" button. It will then automatically update that 
program with the latest definition file available.  
 
There are other times that you need to modify what is enabled or disabled in your build. 

1. Building with XP SP1a instead of SP2- please view this FAQ topic for more information.  
2. Building with Win 2k3 SP1 source- please view this FAQ topic for more information.  
3. Finally of course is the fact that you may want to customized your build, but of course that is all 
up to you. Again though, please build the project as is or only with plugins removed before you 
start ADDING plugins. That way if you have problems we know if it's a problem with UBCD4Win or 
your plugin. If there are some tools included in the project that you do not want feel free to disable 
them. 
 
**Other customization options are discussed on the NEW Customize page of the site. For more 
details and information on customizing your UBCD4Win build, please visit the new page. 
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8. When you are done customizing, "close" the plugin page. Back on the main page go ahead and 
click "build." 

 

9. If you have built the project previously, you will see this screen (you will want to click Yes):  

 

10. If this is the first time building, you will see the Windows EULA message: 
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11. Now the "build" screen: 
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12. Finished successfully!! Below is the finished screen. You can now click "close", then "exit", and 
burn your ISO file to CD. Just make sure you select the correct options in your CD burning 
software.  

 

Changing the GeoShell Style 

By default the "Luna" style is enabled. 
1. Navigate to your "C:\UBCD4Win\oem1\GeoShell" folder  
2. Modify the file "geoshell2_xpluna.inf", line 6 should be the "enable=1", you need to change that to 
"enable=0"  
3. Close and save the file  
4. Modify the file "geoshell2_classic.inf", line 6 should read "enable=0", change that to "enable=1"  
5. NOTE, only one of these styles can be enabled at a time. That is why you need to disable the 
"default" Luna theme before enabling another. There are a few other options in there also so take a 
look at them. If you are unsure about anything please post before "winging it." I am pretty sure the 
"classic" theme is what you wanted so this should be the modification you need.  

Modifying Quick Launch buttons 

1. Place your icon here (assuming you installed UBCD4Win to "C:\UBCD4Win"):  
C:\UBCD4Win\oem1\GeoShell\files\GEOSHELL\ICONS 
2. Modify geoshell.inf  
For this step, you need to locate the current code for SpyBot (below)  
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0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","HotKey",""  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Icon","icons\spybot.ico"  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Parameters",""  
0x2, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Path and 
FileName","%systemdrive%\PROGRAMS\spybot\SpybotSD.EXE"  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Start-In Path",""  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","ToolTip","SpyBot!!"  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Verb",""  
0x4, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Show As", 0x00000001  

 
Here is the edited code, modified for my GAIM plugin:  

0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","HotKey",""  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Icon","icons\gaim.ico"  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Parameters",""  
0x2, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Path and 
FileName","%systemdrive%\PROGRAMS\GAIM\gaim_sfx.EXE"  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Start-In Path",""  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","ToolTip","GAIM"  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Verb",""  
0x4, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Show As", 0x00000001  

 
 
Adding Quick Launch icons 

1. Place your icon here (assuming you installed UBCD4Win to "C:\UBCD4Win"):  
C:\UBCD4Win\oem1\GeoShell\files\GEOSHELL\ICONS  
2. Modify geoshell.inf  
For this step, you need to locate the current code for SpyBot 

0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","HotKey",""  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Icon","icons\spybot.ico"  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Parameters",""  
0x2, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Path and 
FileName","%systemdrive%\PROGRAMS\spybot\SpybotSD.EXE"  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Start-In Path",""  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","ToolTip","SpyBot!!"  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Verb",""  
0x4, "Software\Geo\GeoShell\Plugins\geOLaunch0_2","Show As", 0x00000001  

 
3. Copy the above code and paste it after the last sequence of the above code (after the Xplorer2 
code). Modify it for the program you want to add to your Quick Launch menu, the example below 
shows the changes for my GAIM plugin.  

0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_5","HotKey",""  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_5","Icon","icons\gaim.ico"  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_5","Parameters",""  
0x2, "Software\Geo\GeoShell\Plugins\geOLaunch0_5","Path and 
FileName","%systemdrive%\PROGRAMS\GAIM\gaim_sfx.EXE"  
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0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_5","Start-In Path",""  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_5","ToolTip","GAIM"  
0x1, "Software\Geo\GeoShell\Plugins\geOLaunch0_5","Verb",""  
0x4, "Software\Geo\GeoShell\Plugins\geOLaunch0_5","Show As", 0x00000001  

 
4. Now find this code:  

0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","0","geoLaunch,0_1"  
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","1","geoLaunch,0_2"  
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","2","geoLaunch,0_3"  
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","3","geoLaunch,0_4"  
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","4","geoTasks,0_1"  
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","5","geoSpacer,0_1"  
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","6","geoTray,0_1"  
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","7","geODateTime,0_1"  

 
5. This is the new code:  

0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","0","geoLaunch,0_1"  
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","1","geoLaunch,0_2"  
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","2","geoLaunch,0_3"  
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","3","geoLaunch,0_4"  
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","4","geoLaunch,0_5"  
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","5","geoTasks,0_1"  
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","6","geoSpacer,0_1"  
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","7","geoTray,0_1"  
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar (0)","8","geODateTime,0_1"  

Essentially you are adding a new line and then you up the number by one for each entry after. The 
line added above was:  

 
0x1, "Software\Geo\GeoShell\Services\Plugins\GeoBar 
(0)","4","geoLaunch,0_5"  

 
Compare the two and you will see the difference. 
 
FOR MORE information or help, please view this forum topic HERE. 
Thanks Lawson23 for the instructions! 

How to include a custom image in the BCDW boot menu: 

NOTE: Using the <CONFIG> button does not work. Sorry, that has not been setup yet so you have to 
do everything manually. 
 
1. Navigate to your "C:\UBCD4Win\plugin\Multiboot-003\z_custom\" folder. 
2. Place your .img files in the "\images" sub-folder.  
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3. EDIT custom_bcdw.ini to reflect the boot options you want to display.  
Here is an example of how your INI file should look:  

:                                ; ... Insert your boot options here ...  
;\Images\memtest.img; Memtest86 (BCDW)                       
; ^ Example of floppy images using parameters: 
IMAGE TO RUN ; Program description ; ^displays info an bottom ;(Special codes for 
linux, ect...)  
 

 
 
One more example of floppy image usage is...  
 

\Images\myimage.img ; myprogram ; ^ what myprogram does. 4. ENABLE the 
plugin. 

 
How to include Knoppix in the BCDW boot menu: 

Tom (pcuser) of the development team has created an almost ready to go plugin for including Knoppix 
onto your UBCD4Win DVD. NOTE: almost ready means that the Knoppix ISO is not included and also 
note DVD. UBCD4Win by itself is 500+MB and Knoppix is a 700MB ISO image, so you will have to 
burn the complete ISO to a DVD.  

 
Knoppix 5.01 was used when creating this plugin, newer versions may not work. 
 
1. Download the plugin from HERE  
2. Extract it to your plugins\multiboot folder 
3. Either copy the contents of your KNOPPIX cd to the files folder <or> 
copy the ISO image to the files folder and click the "CONFIG" button on the plugin screen before 
building.  
 
If you need assistance with this plugin, please visit the forum topic HERE.  
For more information on Knoppix, please visit it's site: http://knoppix.net/ 

Slipstreaming SP1a or SP2 to XP, AutoStreamer and Manual Instructions  

AutoStreamer has been released and is availabe for download from the "Download" page. I have just 
added instructions that are straight from the author (Raptor). If you do have question please email me 
or post to in the forum. AutoStreamer is an application that makes slipstreaming easier, it is menu 
driven and includes many features that will help make sure your CD is created properly. 

AutoStreamer Instructions: 

Preparing: 
Extract the ZIP file's contents to a local folder where you have sufficient permissions (meaning 
read/write). Do not extract only AutoStreamer.exe and do not double-click it within the archive. There's 
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high chance things will go wrong. 
 
Running: 
First you have to select between CD or share mode. If you want to use your original xp cd as a source, 
go with cd mode. If you have a network share which contains the setup files, pick share mode. 
 
Step 1: 
--CD Mode: If you pick cd mode, AutoStreamer will attempt to read your pc's cd drives to detect any 
windows cds. If you have already inserted your cd in, AS will find it. If not, insert it, and click on the 
first magnifying glass icon to detect it. After detection suceeds, pick the service pack file by clicking 
the second magnifying glass icon. AS will attempt to detect what kind of file it is. If all goes well and its 
a valid SP file (meaning its the correct version, and newer than the source, it is valid) you will be ready 
to continue to step 2. 
--Share Mode: Same as CD Mode, however, the first magnifying glass will prompt you for a valid hard 
drive location (local or network drive will do). Version detection works here as well. Again, you will 
have to pick SP file, and AS will verify that everything is good to go... 

 

Step 2: 
It's time to label the CD image. you can give any name you want. I usually name it WINXPSP2_EN or 
something... Next you have to pick the output file location... I use C:\WINXPSP2_EN.ISO... 
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If you do not wish to use AutoStreamer to help you create a slipstreamed XP CD, you can always do it 
the hard way and follow my instructions below: 

Manual Instructions:  

So you upgraded to XP right when it came out like me too? Bought XP before SP1 or SP1a came 
out? Slipstreaming look too complicated or not worth the hassle? Don't worry it's very simple, Bart's 
PE© doesn't require it from a CD! So all you have to do is copy the contents of your XP CD to a folder 
on your PC then slipstream SP1 to that. Then when BPE asks for the path of the files, just direct BPE 
to that folder! The instructions are below, several others and I have tested this and it does work. I 
haven't had the time though to see if you could burn the folder (we will create together) to CD and if 
BPE would accept it. The CD couldn't be used for installing XP but it may work for BPE. In order for 
you to burn it to CD and it be able to boot and install Windows from it would require more software 
downloads and I haven't been able to find a free program that would extract the bootloader. Also the 
only burning software that I have seen that will allow you to insert the boot loader image is Nero and 
that isn't for free either!! 

All you need is your XP CD, download SP1a, and follow the instructions below: 

1. Create 2 folders on your computer. For my instructions I will reference C:\WinXP and 
C:\WinSP1folders. 

2. Insert your XP CD. Open Windows Explorer and navigate to the CD drive you have your XP CD in.  

3. You will want to make sure that Explorer is setup to display all hidden and system files to ensure all 
files are listed and therefore can be copied. The setting is located under the menu Tools > Folder 
Options > View tab. Check that the [show hidden files and folders] radio button is selected and the 
[hide protected operating system files] is unchecked.  

4. Select all files and folder that exist on the XP CD and copy them to the "C:\WinXP" folder you just 
created. This should copy all the files from the CD to that folder. 
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**NOTE: It is not necessary to slipstream SP1a and then SP2 if you want to slipstream SP2. So in 
other words if your XP CD does not include SP1 and you want to slipstream SP2, then only use the 
SP2 file. SP2 contains all the updates that were included in SP1a.  

5. Take your SP1 file which if downloaded from my link (MS) should be named "xpsp1a_en_x86.exe", 
and put it in the folder named "C:\WinSP1." Use the "Run" command from your start menu to extract 
SP1a. You will type "C:\WinSP1\xpsp1a_en_x86.exe -x" A dialogue box will appear asking you where 
you would like it extracted. It should show "C:\WinSP1" as the path, if so click ok. If not, browse to that 
folder. 

5a. SP2 Instructions - Now take your SP2 file and put it in a folder named "WinSP2" on your root 
directory of your harddrive. For example the path would be "C:\WinSP2." Use the "Run" command 
from the start menu to slipstream SP2. You will type "C:\WinSP2\ WindowsXP-KB835935-SP2-
ENU.exe /integrate:c:\WinXp" This command will slipstream SP2. Skip step 6 and move onto 7.  

6. Now it is time to actually slipstream it. You will be using the "Run" command again to do this. The 
command to enter in the dialogue box is "C:\WinSP1\Update\Update.exe -S:C:\WinXP" You will see 
several different boxes appear showing you that it is intergrating (slipstreaming) SP1a to XP. When it 
is complete a box will appear announcing "Integrated install has completed successfully." Click "OK" 
and it is done. 

7. You can now go back up to the instructions for Bart's PE instructions - building WinUBCD. In step 4 
you will direct BPE to the "C:\WinXP" folder and it should accept it. 

8. Now as I stated in the description below the title for this help section you may be able to take those 
files in the "C:\WinXP" folder and burn them to CD. If you do not want the 500+ Meg of space used up 
on your harddrive you could try this. If you want it to be bootable though you will need to add the 
imageloader file to the CD compilation before burning. Which will require you to use another 
application designed to extract the bootloader. You will also need CD burning software with the option 
to include the bootloader to the CD, Nero is a good example of an application that allows you to do 
this. I belive newer version of CD Burner XP Pro allows you to do this also but I have not personally 
tested those features. 

 


